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Copyright
Copyright © 2007 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• During testing never activate the GSM transmitter without a proper antenna load, otherwise the GSM PA
may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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 Product selection
The RM-217 and RM-222 are class 4 (max 2W) GSM triband hand portable phones, supporting GSM
850/1800/1900 (RM-222) and 900/1800/1900 (RM-217) bands, respectively. The RM-217/222 also supports
EGPRS and GPRS (Packed data). It is a class B&C terminal, supporting EGPRS multislot class 10 (4Rx + 1Tx and
3Rx + 2Tx) and GPRS multislot class 10 (4+1, 3+2).

The RM-217/222 is MMS (Multimedia Messaging Services) version 1.2 enabled phone with a QVGA 240x320
pixel, active TFT 16.7 million colour display. It also has an integrated 2 Mpix digital camera with a 8 x digtal
zoom.

The RM-217/222 has a 3GPP video player/recorder, FM stereo radio and a music player, and it supports
Bluetooth 2.0 + EDR standard as well as microSD card with hotswap possibility.

The XHTML/WAP browser in RM-217/222 is compatible with the version 2.0 specifications and it supports
HTTP/TCP/IP stack.

In addition the RM-217/222 is a Java-enabled phone (JavaTM 2 Platform, Micro Edition, for embedded devices).
It supports MIDP Java 2.0 with additionally APIs.

The supported user interface is S40, that is, RM-217/222 software is based on the ISA platform.

Figure 1 View of RM-217/222

 Features

Phone features

General features
• Demo mode (phone demo without SIM card)
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Hardware features

Display and keypad features
• Main display: Active TFT QVGA display supporting up to 16,7 million colors (320 x 240 pixels, 2 inches active

area)

• Power switch

• Side volume keys

Hardware characteristics
• Monoblock phone

• 2-Mpix camera with 8 x digital zoom

• Hotswap µSD memory card slot (under the battery cover)

• Stereo FM radio and music player

• Integrated handsfree speaker

• Internal vibra

• Bluetooth

• 2.0 mm DC charger plug interface

• Mini-USB connector

• 2.5mm Nokia AV connector

Software and User interface features

Software features
• ISA OS 8.0s Platform

• Nokia Series 40 User interface (UI): JavaTM MIDP 2.0

UI features

Imaging • 2.0-megapixel camera with 8x digital zoom (1600 x 1200 pixel
resolution)

• Full-screen viewfinder

• PictBridge printing via USB cable

Multimedia • MP3 player supporting formats including MP3, Midi, AAC, AAC+, enhanced
AAC+, WMA

• FM stereo radio, Visual Radio and music player

• 3GPP video player/recorder

• MP3 ringing tones, True tones and MIDI tones, with support of 64
polyphony

Memory functions • Combo memory with 32 MB flash and 16 MB RAM – about 7 MB user
memory (for gallery and applications, contacts, notes, calendar entries)

• Hotswap microSD memory card slot supporting up to 2GB microSD
memory cards (available as enhancements)
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Messaging • Simplified messaging with recently used contacts log and groups

• Email: Access your work and private email accounts; supports SMTP,
POP3, and IMAP4 protocols. Support for attachments (Java version)

• Audio messaging service (AMS): Record your own voice message and send
to compatible devices

• MMS OMA 1.2: Combine image, video, text, and voice clips and send as an
MMS to a compatible phone or PC; use MMS to tell your story with a multi-
slide presentation. The MMS OMA 1.2 specification allows you to send/
receive messages up to 300 kB in size.

• Text messaging: Supports concatenated SMS, picture messaging, SMS
distribution list

• Predictive text input: Support for all major languages in Europe and Asia-
Pacific

• Instant Messaging (IM)

Applications • Java™ MIDP 2.0 with over-the-air download

• Pre-installed Java™-based applications and games

• SIM Application Toolkit

• Wireless Presenter

Connectivity • Nokia PC Suite with USB and Bluetooth connectivity

• Bluetooth wireless connectivity (SIM access, headset, and handsfree
profiles) incl. stereo support for headsets

• Nokia AV connector interface with USB

• FOTA (Flashing over-the-air)

• Local/remote SyncML data synchronization

Browsing • Integrated XHTML browser

• Smart content download - OMA DRM 2.0

Data transfer • EDGE (EGPRS): Class 10, download up to 236.8 kbps

• GPRS: Class 10, download up to 53.6 kbps

Note: Actual achieved speeds may vary depending on network support

• GPRS/EDGE/HSCSD/CSD for browsing and as data modem

• Downlink Advanced Receiver Performance (DARP)

Voice features • Push To Talk: Select the person or group you want to talk to and press
the Push To Talk key to communicate

• Enhanced voice dialling with SIND: Speaker-independent name dialling
for easy call handling

• Integrated handsfree speaker with a new high quality speaker for better
audio experience (stereo widening effects when attaching the headset)

• Voice commands

• Voice recorder
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Digital services • User Interface (UI) themes including e.g. animated wallpapers,
screensavers, color schemes, ringing tones

• Ringing tones: Video, MP3 ringing tones, True Tones and MIDI ringing,
alert, and gaming tones with support of 64 polyphony

• OTA download possibility for: Themes, True Tones, MP3 ringing tones,
MIDI ringing tones, screensavers, wallpapers, 3GPP streaming, images
and videos, Series 40 Java games and applications

Personal information
management (PIM)

• Organizer with alarm clock, calendar, to-do list, notes, calculator,
countdown timer, and stopwatch

• Manage your time and information with the enhanced calendar that can
be synchronized, for example, with Microsoft and Lotus PIM application
calendars by using the Nokia PC Suite

Call management • Speed dialling

• Logs: Keeps lists of your dialled, received, and missed calls

• Automatic answer (works with headset or car kit only)

• Call waiting, call hold, call divert, call timer

 Accessories

Table 1 Audio

Type Name

AD-42W Wireless audio gateway

HS-40 Mono headset

HS-16, HS-42,
HS-47

Stereo headsets

BH-300,
BH-601,
BH-700,
BH-800,
BH-900,
HS-4W,
HS-50W

Wireless mono headsets

HS-21W,
HS-24W,
HS-25W,
HS-26W,
HS-34W,
HS-36W,
HS-37W,
HS-57W,
HS-58W

Wireless stereo headsets
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Table 2 Battery and chargers

Type Name

Note: This phone is charged through the smaller Nokia standard interface (2.0 mm plug). The 3.5 mm
standard charger can be used together with the CA-44 charger adapter.

AC-3/AC-5 Compact charger

AC-4 Travel charger

BL-4C Battery 860 mAh Li-Ion

CA-44 Charger adapter (from 3.5 mm -> 2 mm)

Table 3 Car accessories

Type Name

CK-1W Wireless car kit

CK-7W Basic universal car kit

CK-20W Car Installation Kit

CR-39 Universal holder

DC-4 Mobile charger

HF-35W Wireless Car Handsfree

N616 Car phone

Table 4 Data

Type Name

DKE-2 Mini USB connectivity cable

MU-22 1 GB µSD card

MU-26 128 MB µSD card

MU-27 256 MB µSD card

MU-28 512 MB µSD card

MU-37 2 GB µSD card

Table 5 Imaging

Type Name

PT-6 Remote camera
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 Exploded view

Exploded view
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Mechanical spare parts overview
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 Parts list

Mechanical spare parts list

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Ax and in bold = ASSY

"-" = NOT AVAILABLE

"XXXXXXX" = VARIANTS

"???????" = Code available in Bulletin

I0xx = ITEM codes for upper or mono block

I1xx = ITEM codes for hinge block

I2xx = ITEM codes for lower block

I3xx = ITEM codes for soldered spare parts on the upper, hinge or lower block and not exchangeable

ITEM/
CIRCUIT

REF.
QTY PART NAME Note

I0001 1 A-COVER ASSY

I0002 1 KEYMAT

I0003 4 SCREW 1.6X4.5 TORX PLUS

I0004 1 UI SHIELD ASSEMBLY

I0005 1 LCD MODULE

A1 1 1YW LIGHT SWAP PACKAGE (I0006 -
I0014)

I0006 1 DOMESHEET Cannot be reused when removed.

I0007 1 1YW LIGHT SWAP PWB

I0008 1 FM SHIELDING LID Cannot be reused when removed.

I0009 1 RETU-TAHVO SHIELDING LID Cannot be reused when removed.

I0010 1 RAP MEM SHIELDING LID Cannot be reused when removed.

I0011 1 HWA SHIELDING LID Cannot be reused when removed.

I0012 1 RF SHIELDING LID Cannot be reused when removed.

I0013 1 BT SHIELDING LID Cannot be reused when removed.

I0014 1 TYPE LABEL Cannot be reused when removed.

I0015 1 CAMERA GASKET

I0016 1 CAMERA

I0017 1 FLEX SHIELDING LID ASSY Cannot be reused when removed.

A2 1 ANTENNA MODULE ASSY (I0018 -
I0021)

I0018 1 EARPIECE ASSEMBLY

RM-217; RM-222
Parts and layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –7
Copyright © 2007 Nokia. All rights reserved.



ITEM/
CIRCUIT

REF.
QTY PART NAME Note

I0019 1 PLASTIC CHAMBER

I0020 1 IHF SPEAKER

I0021 1 ANTENNA RADIATOR

A3 1 B-COVER ASSY (I0022 - I0030)

I0022 1 B-COVER

I0023 1 POWER KEY

I0024 1 VOLUME KEY

I0025 1 SIDE WINDOW RIGHT

I0026 1 LED WINDOW LEFT

I0027 1 MICROPHONE

I0028 1 DC JACK

I0029 1 USB DOOR

I0030 1 LABEL COVER ASSY

I0031 2 SCREW 1.6 x 4.5 REMFORM TORX PLUS

I0032 1 C-COVER

I9998 1 WATER INGRESS LABEL

Note

Antenna Module is marked 850 or 900 to enable identification of different versions by regions.

Component parts list (1ywa_32a)

Item Side Grid Description and value

A2200 Bottom K 3 SHIELD_040_025976
RETU TAHVO SHIELD ASSY
040-025976 P2912

A2400 Bottom T 3 SHIELD_0264510
FLEX SHIELD FRAME 031886
P2908

A2800 Bottom K 7 SHIELD_040_025979
RAP_MEM SHIELD ASSY
040-025979 P2912

A3300 Bottom O 8 SHIELD_040_025020
HW_ACC ASSEMBLY 040-025020
P2912

A6000 Bottom Q 2 SHIELD_040_031454 BT SHIELD ASSY 031454 P2908

A6100 Bottom G 6 SHIELD_040_031457 FM SHIELD ASSY 031457 P2908

A7000 Bottom R 6 SHIELD_040_009342 RF ASSEMBLY 040-009342 P2465
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Item Side Grid Description and value

B2100 Bottom B 8
MIC_OBE_415S42_RC3310C
L_CARBON

CLAPTON EMC MICROPHONE MOD
-42DB

B2101 Bottom T 6 SPEAKER_LTR_RDF_COMB
EARP RDF-07A 32OHM
10.86x7.40.2.25

B2200 Bottom M 3 CRYSTAL_3.3X1.6_H0.9
CRYSTAL 32.768KHZ +/-30PPM
12.5PF

C2000 Top A 4 0402C CHIPCAP NP0 27P J 50V 0402

C2001 Top A 3 0603C_H0.95 CHIPCAP X5R 470N K 25V 0603

C2002 Top A 5 0603C CHIPCAP X7R 10N K 50V 0603

C2008 Bottom C 2 0402C CHIPCAP X7R 1N0 K 50V 0402

C2030 Bottom E 5 0402C CHIPCAP NP0 270P J 50V 0402

C2031 Bottom E 5 0402C CHIPCAP X7R 1N0 K 50V 0402

C2032 Bottom D 5 0402C CHIPCAP X7R 10N K 16V 0402

C2033 Bottom E 4 0402C CHIPCAP X7R 33N K 10V 0402

C2034 Bottom E 4 0402C CHIPCAP X7R 33N K 10V 0402

C2035 Bottom C 5 0402C CHIPCAP NP0 27P J 50V 0402

C2040 Bottom H 5 0603C CHIPCAP X5R 2U2 K 6V3 0603

C2041 Bottom C 3 0603C CHIPCAP X5R 2U2 K 6V3 0603

C2042 Bottom D 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2043 Bottom C 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2044 Bottom C 4 0402C CHIPCAP NP0 18P J 50V 0402

C2045 Bottom D 5 0402C CHIPCAP NP0 18P J 50V 0402

C2046 Bottom C 4 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2047 Bottom C 4 0603C CHIPCAP X5R 4U7 K 6.3V 0603

C2048 Bottom C 3 0603C CHIPCAP X5R 2U2 K 6V3 0603

C2049 Bottom H 5 0603C CHIPCAP X5R 1U K 6V3 0603

C2050 Bottom D 5 0402C CHIPCAP X7R 10N K 16V 0402

C2051 Bottom H 5 0603C CHIPCAP X5R 1U K 6V3 0603

C2052 Bottom C 5 0402C CHIPCAP NP0 27P J 50V 0402

C2071 Bottom Q 3 0402C CHIPCAP NP0 27P J 50V 0402

C2073 Bottom S 2 TANT_C_6.2X3.4_H1.7 CHIPTCAP 150U M 10V 6X3.2X1.5

C2074 Bottom L 2 0402C CHIPCAP X7R 10N K 16V 0402

C2076 Bottom Q 4 0402C CHIPCAP X7R 10N K 16V 0402

C2077 Bottom M 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2078 Bottom M 2 0402C CHIPCAP NP0 27P J 50V 0402

C2079 Bottom E 4 0402C CHIPCAP X7R 1N0 K 50V 0402
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Item Side Grid Description and value

C2080 Bottom E 4 0402C CHIPCAP X7R 10N K 16V 0402

C2100 Bottom G 5 0402C CHIPCAP X7R 33N K 10V 0402

C2101 Bottom F 5 0402C CHIPCAP X7R 33N K 10V 0402

C2102 Bottom H 5 0603C CHIPCAP X5R 2U2 K 6V3 0603

C2103 Bottom O 1 0402C CHIPCAP NP0 27P J 50V 0402

C2104 Bottom O 2 0402C CHIPCAP NP0 27P J 50V 0402

C2200 Bottom M 5 0603C CHIPCAP X5R 1U K 6V3 0603

C2201 Bottom M 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2202 Bottom N 2 0402C CHIPCAP X7R 1N0 K 50V 0402

C2203 Bottom M 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2204 Bottom M 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2205 Bottom M 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2206 Bottom M 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2207 Bottom N 2 0402C CHIPCAP X7R 1N0 K 50V 0402

C2208 Bottom N 3 0402C CHIPCAP NP0 27P J 50V 0402

C2209 Bottom N 3 0402C CHIPCAP NP0 22P J 50V 0402

C2210 Bottom K 3 0603C CHIPCAP X5R 1U K 16V 0603

C2211 Bottom K 3 0805C CHIPCAP X5R 4U7 K 10V 0805

C2212 Bottom K 3 0402C CHIPCAP X5R 1U5 K 4V 0402

C2213 Bottom L 3 0402C CHIPCAP X5R 1U5 K 4V 0402

C2214 Bottom L 2 0402C CHIPCAP X5R 1U5 K 4V 0402

C2215 Bottom L 2 0402C CHIPCAP X5R 1U5 K 4V 0402

C2216 Bottom L 2 0402C CHIPCAP X5R 1U5 K 4V 0402

C2217 Bottom M 3 0402C CHIPCAP X5R 1U5 K 4V 0402

C2219 Bottom M 2 0402C CHIPCAP X5R 1U5 K 4V 0402

C2220 Bottom K 3 0402C CHIPCAP X5R 1U5 K 4V 0402

C2221 Bottom K 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2222 Bottom K 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2223 Bottom L 4 0402C CHIPCAP X7R 10N K 16V 0402

C2224 Bottom M 4 0402C CHIPCAP X7R 10N K 16V 0402

C2225 Bottom M 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2226 Bottom L 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2227 Bottom K 3 0603C CHIPCAP X5R 1U K 6V3 0603

C2228 Bottom L 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2230 Bottom M 3 0603C CHIPCAP X5R 1U K 6V3 0603
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C2231 Bottom K 5 0805C CHIPCAP X5R 10U M 6V3 0805

C2232 Bottom L 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2270 Bottom L 5 0402C CHIPCAP X7R 1N0 K 50V 0402

C2271 Bottom L 5 0402C CHIPCAP X7R 1N0 K 50V 0402

C2272 Bottom L 5 0402C CHIPCAP X7R 1N0 K 50V 0402

C2273 Bottom K 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2274 Bottom K 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2275 Bottom K 4 0402C CHIPCAP X7R 1N0 K 50V 0402

C2281 Bottom L 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2300 Bottom J 4 0402C CHIPCAP X7R 10N K 16V 0402

C2301 Bottom I 4 0805C CHIPCAP X5R 22U M 6V3 0805

C2302 Bottom K 5 0805C CHIPCAP X5R 22U M 6V3 0805

C2303 Bottom I 3 0603C CHIPCAP X5R 1U K 6V3 0603

C2304 Bottom K 4 0402C CHIPCAP X7R 10N K 16V 0402

C2305 Bottom I 2 0603C CHIPCAP X5R 1U K 6V3 0603

C2306 Bottom I 4 0603C CHIPCAP X5R 1U K 6V3 0603

C2307 Bottom I 4 0603C CHIPCAP X5R 1U K 6V3 0603

C2309 Bottom I 5 0805C CHIPCAP X5R 22U M 6V3 0805

C2312 Bottom I 3 0603C CHIPCAP X5R 1U K 6V3 0603

C2313 Bottom I 3 0603C CHIPCAP X5R 1U K 6V3 0603

C2314 Bottom J 2 0805C CHIPCAP X5R 4U7 K 10V 0805

C2315 Bottom K 2 0805C CHIPCAP X5R 4U7 M 25V 0805

C2317 Bottom J 2 0402C CHIPCAP NP0 27P J 50V 0402

C2403 Bottom N 2 0402C CHIPCAP NP0 47P J 50V 0402

C2404 Bottom T 2 0402C CHIPCAP X7R 4N7 K 25V 0402

C2405 Bottom T 4 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2413 Bottom I 2 0402C CHIPCAP NP0 27P J 50V 0402

C2414 Bottom T 2 0402C CHIPCAP NP0 27P J 50V 0402

C2415 Bottom T 4 0402C CHIPCAP NP0 27P J 50V 0402

C2416 Bottom T 3 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2417 Bottom T 3 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2418 Bottom T 3 0402C CHIPCAP NP0 27P J 50V 0402

C2700 Bottom H 2 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2701 Bottom H 2 0402C CHIPCAP NP0 27P J 50V 0402

C2800 Bottom L 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402
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C2801 Bottom N 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2802 Bottom M 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2803 Bottom L 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2804 Bottom N 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2805 Bottom K 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2807 Bottom N 8 0603C CHIPCAP X5R 1U K 6V3 0603

C2808 Bottom M 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2809 Bottom M 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2810 Bottom K 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2811 Bottom K 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2812 Bottom L 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2813 Bottom N 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2814 Bottom M 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2815 Bottom K 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2816 Bottom K 8 0402C CHIPCAP NP0 27P J 50V 0402

C2818 Bottom K 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2819 Bottom K 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2820 Bottom N 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C2821 Bottom N 6 0402C CHIPCAP NP0 27P J 50V 0402

C2831 Bottom N 7 0402C CHIPCAP NP0 1P0 C 50V 0402

C3000 Bottom I 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3001 Bottom J 6 0402C CHIPCAP X7R 10N K 16V 0402

C3002 Bottom J 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3003 Bottom K 8 0402C CHIPCAP X7R 10N K 16V 0402

C3004 Bottom K 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3005 Bottom J 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3006 Bottom I 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3007 Bottom J 8 0402C CHIPCAP X7R 10N K 16V 0402

C3008 Bottom J 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3009 Bottom I 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3010 Bottom N 5 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3013 Bottom K 7 0402C CHIPCAP NP0 27P J 50V 0402

C3014 Bottom K 7 0402C CHIPCAP NP0 68P J 50V 0402

C3100 Bottom E 2 0402C CHIPCAP NP0 27P J 50V 0402

C3115 Bottom O 7 0402C CHIPCAP X5R 1U K 6V3 0402
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C3116 Bottom O 7 0402C CHIPCAP X7R 10N K 16V 0402

C3200 Bottom G 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3201 Bottom H 8 0402C CHIPCAP X5R 1U K 6V3 0402

C3202 Bottom H 7 0402C CHIPCAP X7R 10N K 16V 0402

C3203 Bottom G 8 0402C CHIPCAP X5R 1U K 6V3 0402

C3204 Bottom H 7 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3210 Bottom G 8 0402C CHIPCAP NP0 27P J 50V 0402

C3211 Top D 8 0402C CHIPCAP NP0 27P J 50V 0402

C3300 Bottom P 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3301 Bottom N 5 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3302 Bottom N 4 0402C CHIPCAP X5R 220N K 6.3V 0402

C3303 Bottom O 8 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C3304 Bottom O 8 0402C CHIPCAP X7R 10N K 16V 0402

C3305 Bottom O 6 0603C CHIPCAP X5R 4U7 K 6.3V 0603

C3306 Bottom O 8 0603C CHIPCAP X5R 4U7 K 6.3V 0603

C3307 Bottom O 8 0603C CHIPCAP X5R 10UF 6V3 0603

C3308 Bottom N 5 0402C CHIPCAP X5R 1U K 6V3 0402

C3309 Bottom N 5 0402C CHIPCAP NP0 27P J 50V 0402

C3310 Bottom P 6 0402C CHIPCAP NP0 27P J 50V 0402

C3313 Bottom O 8 0402C CHIPCAP X7R 10N K 16V 0402

C3314 Bottom P 8 0402C CHIPCAP X7R 10N K 16V 0402

C6020 Bottom T 2 0402C CHIPCAP NP0 1P5 C 50V 0402

C6031 Bottom R 1 0402C CHIPCAP NP0 18P J 50V 0402

C6032 Bottom P 2 0402C CHIPCAP NP0 100P J 50V 0402

C6033 Bottom P 2 0402C CHIPCAP X7R 10N K 16V 0402

C6034 Bottom P 2 0402C CHIPCAP X7R 10N K 16V 0402

C6035 Bottom P 1 0402C CHIPCAP X7R 10N K 16V 0402

C6036 Bottom P 2 0402C CHIPCAP X7R 10N K 16V 0402

C6037 Bottom P 2 0402C CHIPCAP X5R 1U5 K 4V 0402

C6038 Bottom Q 1 0402C CHIPCAP X7R 10N K 16V 0402

C6039 Bottom Q 2 0402C CHIPCAP NP0 18P J 50V 0402

C6040 Bottom P 2 0402C CHIPCAP X5R 1U K 6V3 0402

C6051 Bottom Q 2 0402C CHIPCAP NP0 2P7 C 50V 0402

C6052 Bottom Q 2 0402C CHIPCAP NP0 2P7 C 50V 0402

C6055 Bottom Q 2 0603C CHIPCAP X5R 1U K 6V3 0603

RM-217; RM-222
Parts and layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –13
Copyright © 2007 Nokia. All rights reserved.



Item Side Grid Description and value

C6100 Bottom G 7 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C6101 Bottom H 6 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C6102 Bottom G 7 0402C CHIPCAP X7R 10N K 16V 0402

C6103 Bottom G 7 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C6104 Bottom H 6 0402C CHIPCAP NP0 47P J 50V 0402

C6105 Bottom G 6 0402C CHIPCAP NP0 100P J 50V 0402

C6106 Bottom H 6 0402C CHIPCAP NP0 27P J 50V 0402

C6107 Bottom H 6 0405_2_P0.65_AVX
CHIP ARRAY X5R 2X100N M 10V
0405

C6108 Bottom H 6 0405_2_P0.65_AVX
CHIP ARRAY X5R 2X100N M 10V
0405

C6109 Bottom G 6 0402C CHIPCAP X5R 1U5 K 4V 0402

C7000 Bottom U 8 0402C CHIPCAP NP0 1P5 C 50V 0402

C7001 Bottom T 8 0402C CHIPCAP NP0 1P5 C 50V 0402

C7010 Bottom N 5 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C7011 Bottom N 4 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C7012 Bottom N 5 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C7013 Bottom N 4 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C7501 Bottom S 5 0402C CHIPCAP NP0 2P7 C 50V 0402

C7502 Bottom Q 5 0402C CHIPCAP NP0 0P5 C 50V 0402

C7503 Bottom Q 4 0603C CHIPCAP X5R 1U K 6V3 0603

C7504 Bottom S 5 0603C CHIPCAP X5R 1U K 6V3 0603

C7505 Bottom Q 4 0402C CHIPCAP X5R 1U K 6V3 0402

C7506 Bottom Q 4 0402C CHIPCAP X5R 1U K 6V3 0402

C7507 Bottom Q 4 0402C CHIPCAP X7R 10N K 16V 0402

C7508 Bottom Q 5 0402C CHIPCAP NP0 18P J 50V 0402

C7509 Bottom R 4 0402C CHIPCAP X7R 10N K 16V 0402

C7511 Bottom R 4 0603C CHIPCAP NP0 2N2 G 16V 0603

C7513 Bottom Q 4 0402C CHIPCAP X7R 10N K 16V 0402

C7515 Bottom S 4 0402C CHIPCAP NP0 4P7 C 50V 0402

C7516 Bottom S 4 0402C CHIPCAP NP0 470P J 50V 0402

C7518 Bottom Q 5 0402C_H0.6 CHIPCAP X5R 100N K 16V 0402

C7520 Bottom S 8 0402C CHIPCAP NP0 3P3 C 50V 0402

C7521 Bottom S 8 0402C CHIPCAP NP0 1P5 C 50V 0402

C7522 Bottom Q 8 0402C CHIPCAP NP0 1P8 C 50V 0402
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C7523 Bottom S 8 0402C CHIPCAP X5R 1U K 6V3 0402

C7524 Bottom Q 7 0402C CHIPCAP X5R 1U K 6V3 0402

C7525 Bottom Q 9 0402C CHIPCAP NP0 18P J 50V 0402

C7560 Bottom R 3 0402C CHIPCAP NP0 1P2 C 50V 0402

C7561 Bottom R 4 0402C CHIPCAP X7R 820P J 50V 0402

C7562 Bottom Q 6 0402C CHIPCAP NP0 39P J 50V 0402

C7563 Bottom Q 5 0402C CHIPCAP NP0 47P J 50V 0402

C7564 Bottom S 4 0402C CHIPCAP X7R 10N K 16V 0402

C7565 Bottom Q 5 0402C CHIPCAP NP0 47P J 50V 0402

C7566 Bottom R 4 0402C CHIPCAP NP0 4P7 C 50V 0402

D2200 Bottom L 3 TFBGA_108
RETU 3.02 LF TSA1GJWE
TFBGA108

D2800 Bottom L 7 UBGA_289
RAPGSM PA v1.1 LF C027
uBGA289

D3000 Bottom J 7 FBGA133_11.1X10.1
COMBO 256M NOR + 128M DDR
DRAM FBGA133

D3300 Bottom O 7 TFBGA84 HW ACCELERATOR STV0984N

E2001 Bottom D 4 PICK_PLACE_9900821 No description in PDM

E2002 Bottom A 6 PICK_PLACE_9900821 No description in PDM

E2003 Bottom D 4 PICK_PLACE_9900821 No description in PDM

E2010 Bottom A 7 PICK_PLACE_9900821 No description in PDM

E2070 Bottom P 3 PICK_PLACE_9900821 No description in PDM

E2071 Bottom P 3 PICK_PLACE_9900821 No description in PDM

E2075 Bottom P 4 PICK_PLACE_9900821 No description in PDM

E2101 Bottom Q 6 CLIP_040_034164 No description in PDM

E2102 Bottom Q 9 CLIP_040_034164 No description in PDM

E2103 Bottom U 6 BT_PAD_9900503 No description in PDM

E2104 Bottom T 6 BT_PAD_9900503 No description in PDM

E2105 Bottom U 7 BT_PAD_9900503 No description in PDM

E2106 Bottom T 6 BT_PAD_9900503 No description in PDM

E2401 Top C 9 PICK_PLACE_9900821 No description in PDM

E2402 Top C 1 PICK_PLACE_9900821 No description in PDM

E2403 Top N 1 PICK_PLACE_9900821 No description in PDM

E2405 Top T 9 PICK_PLACE_9900821 No description in PDM

E2407 Top N 9 PICK_PLACE_9900821 No description in PDM

E2506 Top T 1 PICK_PLACE_9900821 No description in PDM
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E6001 Bottom T 1 CLIP_040_034164 No description in PDM

E6003 Bottom T 1 CLIP_040_034164 No description in PDM

E7000 Bottom U 8 PICK_PLACE_9900821 No description in PDM

E7001 Bottom U 5 PICK_PLACE_9900821 No description in PDM

E7501 Bottom T 9 CLIP_040_034164 No description in PDM

E7502 Bottom T 9 CLIP_040_034164 No description in PDM

E7503 Bottom U 8 CLIP_040_034164 No description in PDM

F2000 Top A 5 0402_FUSE_AVX_H0.5 SM FUSE FF 2A 32V 0402

G2200 Bottom C 2 BATTER_EECEP
RTC BACKUP CAPAC 311 SIZE FOR
2.6V 4UAH

G7500 Bottom S 4 VCO_DCS02733 VCO 3296-3980MHZ 4-BAND

G7501 Bottom Q 3 NKG3176B_H1.0 VCTCXO 38.4MHZ 2.5V 2MA

L2000 Top A 5 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2030 Bottom C 5 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2031 Bottom C 4 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2032 Bottom D 5 COIL_LK_1608
CHIP COIL 68NH J Q12/100MHZ
0603

L2033 Bottom D 5 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2034 Bottom D 5 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2035 Bottom C 5 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2102 Bottom Q 7 COIL_LQW1608
CHIP COIL 56N J Q38/200MHZ
0603

L2103 Bottom Q 8 COIL_LQW1608
CHIP COIL 56N J Q38/200MHZ
0603

L2104 Top A 7 0405_2_H1.0
CHIP BEAD ARRAY 2X1000R 0R75
0405

L2105 Bottom O 2 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2106 Bottom O 2 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2202 Bottom M 2 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2207 Bottom N 4 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402
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L2208 Bottom N 4 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2209 Bottom M 5 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2210 Bottom M 5 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2211 Bottom M 4 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2212 Bottom M 4 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2270 Bottom L 4 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2271 Bottom L 4 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2272 Bottom K 4 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2273 Bottom K 4 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2301 Bottom I 4 0603_BLM
FERR.BEAD 220R/100M 2A 0R05
0603

L2302 Bottom J 4 CHOKE_SER400_H1.2
INDUCT WW 10U 0A65 0R35
4X4X1.2

L2304 Bottom J 2 CHOKE_SER300_H1.5
CHOKE 22U M 0R7 0.35A
3.0X3.0X1.5

L2305 Bottom I 3 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2306 Bottom I 3 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2402 Bottom T 3 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2403 Bottom J 2 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L2404 Bottom T 3 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L2405 Bottom O 2 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L3200 Bottom G 8 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L3301 Bottom N 6 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402
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L3303 Bottom P 8 CHOKE_SER300
INDUCT WW 2.2UH 1A2 0R168
310 case size

L3304 Bottom O 9 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L6030 Bottom Q 2 0402L
CHIP COIL 2N7 +-0N3 Q29/800M
0402

L6031 Bottom Q 2 0402L
CHIP COIL 2N7 +-0N3 Q29/800M
0402

L6032 Bottom Q 1 0402L
CHIP COIL 22N J Q28/800MHZ
0402

L6077 Bottom R 2 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L6100 Bottom G 7 0402LQW
CHIP COIL 47N +-3%
Q25/200MHz 0402

L6101 Bottom H 6 0402L_POL2
CHIP COIL 120NH J Q8/100MHZ
0402

L7010 Bottom N 5 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L7011 Bottom N 4 0402L
FERR.BEAD 240R/100M 0.4A 0R4
0402

L7500 Bottom S 6 0402L
CHIP COIL 12N J Q31/800MHZ
0402

L7501 Bottom S 6 0402L
CHIP COIL 12N J Q31/800MHZ
0402

L7502 Bottom Q 5 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

L7503 Bottom Q 8 0402L
CHIP COIL 27N J Q27/800MHZ
0402

L7504 Bottom R 6 0402L
CHIP COIL 22N J Q28/800MHZ
0402

L7505 Bottom R 6 0402L
CHIP COIL 22N J Q28/800MHZ
0402

L7515 Bottom S 4 0402L
CHIP COIL 15N J Q30/800MHZ
0402

L7561 Bottom Q 6 COIL_HK_1608 CHIP COIL 470NH J 0603

M2100 Bottom C 8 VIBRA_M_KHN4NX1RA
SMD VIBRA MOTOR 1.3V 90MA
9000RPM

N2030 Bottom D 5 CSP_8_2.118X1.118
IC ANALOG SWITCH SPDT LOW
THRESHOLD CSP8

N2031 Bottom C 3 XBGA_N14
ST HEADPHONE AMPLIFIER
LM4920 uSMD14
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N2300 Bottom J 3 TFBGA_84_6.15X6.15 TAHVO v5.2 LF TFBGA84

N2301 Bottom J 2 USMD8_1.69X1.69
WHITE LED DRIVER 4LEDS
500mW 8bump USMD8

N2401 Bottom G 5 SOT_666
TRX2+RX4 PEMD9 N&P 10K/47K
0W12 SOT666

N3200 Bottom G 8 USMD16_2.03X2.03
VREG & LEVELSHIFT(LP3928)
USMD16

N3300 Bottom O 8 USMD5_1.417X1.087
DC/DC CONV LM3671TLX-1.82V
uSMD5

N3301 Bottom O 6 USMD5_1.47X1.04_H0.675
VREG LP3985ITLX-2.8 NOPB
USMD5

N6030 Bottom P 2 CSP_47_3.85X4.05 BC4-ROM1.0RDL

N6100 Bottom H 7 WLCSP25_3.1X2.9 FM RECEIVER TEA5760 N1C

N7505 Bottom R 5 TFBGA144
AHNE401A TRANSCEIVER
TFBGA144

N7520 Bottom R 8 RF9282E3.6
PA RF9282E6.5 GSM/EDGE
850/900/1800/1900

R2007 Bottom C 2 UBGA11_1.6X2.15 ASIP SILIC USB OTG / ESD BGA11

R2008 Bottom C 2 0402R CHIPRES 0W06 220K J 0402

R2033 Bottom E 5 0402R CHIPRES 0W06 10K J 0402

R2034 Bottom E 5 0402R CHIPRES 0W06 100R J 0402

R2035 Bottom D 5 0402R CHIPRES 0W06 100K J 0402

R2036 Bottom D 5 0402R CHIPRES 0W06 10K J 0402

R2044 Bottom H 5 0402R CHIPRES 0W06 220R J 0402

R2045 Bottom E 5 0402R CHIPRES 0W06 2K2 J 0402

R2049 Bottom D 4 0402R CHIPRES 0W06 15R J 0402

R2050 Bottom C 4 0402R CHIPRES 0W06 15R J 0402

R2051 Bottom C 5 FC5_1.1X1.1
ASIP TVS 4-CH BI ESD 14V 15pF
400um BGA5

R2052 Bottom C 4 0402R CHIPRES 0W06 100K J 0402

R2070 Bottom E 2 0402_NTH5
NTC RES 0W1 47K J B 4050+-3%
0402

R2071 Bottom N 2 0402_VAR
CHIP VARISTOR VWM14V VC50V
0402

R2072 Bottom E 4 0402R CHIPRES 0W06 2K2 J 0402

R2074 Bottom E 5 0402R CHIPRES 0W06 100R J 0402

R2100 Bottom H 5 FLIP_CHIP_8_1.7X1.7
ASIP SINGLE ENDED MICROPHONE
INTERF BGA8
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Item Side Grid Description and value

R2101 Bottom H 5 0402R CHIPRES 0W06 220R J 0402

R2102 Bottom T 5 0402R CHIPRES 0W06 10R J 0402

R2103 Bottom T 5 0402R CHIPRES 0W06 10R J 0402

R2104 Top A 8 0402R CHIPRES JUMPER 0R0 0402

R2105 Top A 8 0402R CHIPRES JUMPER 0R0 0402

R2106 Bottom N 5 0402_VAR
CHIP VARISTOR VWM14V VC50V
0402

R2107 Bottom N 5 0402_VAR
CHIP VARISTOR VWM14V VC50V
0402

R2200 Bottom M 2 0402R CHIPRES 0W06 100K J 0402

R2201 Bottom N 2 0402R CHIPRES 0W06 120K J 0402

R2202 Bottom M 5 0402R CHIPRES JUMPER 0R0 0402

R2203 Bottom M 5 0402R CHIPRES JUMPER 0R0 0402

R2204 Bottom M 5 0402R CHIPRES JUMPER 0R0 0402

R2205 Bottom M 5 0402R CHIPRES JUMPER 0R0 0402

R2212 Bottom L 4 0402R CHIPRES 0W06 470R J 0402

R2213 Bottom N 3 0402R CHIPRES 0W06 4K7 J 0402

R2216 Bottom N 3 0402R CHIPRES 0W06 2M2 J 0402

R2250 Bottom N 2 0402R CHIPRES 0W06 100K J 0402

R2251 Bottom N 2 0402R CHIPRES 0W06 100K J 0402

R2303 Bottom H 3 0603R CHIPRES JUMPER 0R0 0603

R2400 Bottom G 4 0603R CHIPRES JUMPER 0R0 0603

R2406 Bottom N 2 0402R CHIPRES 0W06 27K J 0402

R2407 Bottom H 5 0402R CHIPRES 0W06 47R J 0402

R2408 Bottom G 4 0402R CHIPRES 0W06 22K J 0402

R2418 Bottom H 4 0402R CHIPRES 0W06 470R J 0402

R2419 Bottom H 5 0402R CHIPRES 0W06 470R J 0402

R2421 Bottom K 2 0402R CHIPRES 0W06 33R J 0402

R2422 Bottom G 5 0402R CHIPRES JUMPER 0R0 0402

R2423 Bottom G 5 0402R CHIPRES 0W06 22K J 0402

R2424 Bottom I 4 0402R CHIPRES 0W06 27R J 0402

R2425 Bottom G 4 0402R CHIPRES 0W06 1K0 J 0402

R2426 Bottom N 9 0402R CHIPRES 0W06 47R J 0402

R2427 Bottom L 1 0402R CHIPRES 0W06 47R J 0402

R2430 Bottom G 4 0402R CHIPRES 0W06 22K J 0402
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Item Side Grid Description and value

R2803 Bottom L 8 0402R CHIPRES 0W06 100R J 0402

R2804 Bottom L 8 0402R CHIPRES 0W06 100R J 0402

R3000 Bottom J 6 0402R CHIPRES 0W06 4K7 J 0402

R3002 Bottom L 8 0402R CHIPRES 0W06 10R J 0402

R3003 Bottom K 6 0402R CHIPRES 0W06 4K7 J 0402

R3004 Bottom K 7 0402R CHIPRES 0W06 4K7 J 0402

R3200 Bottom G 8 UBGA11_1.62X2.12 ASIP MMC FILTER *** PB-FREE ***

R3201 Bottom H 8 0402R CHIPRES 0W06 100K J 0402

R3202 Bottom H 8 0402R CHIPRES 0W06 100K J 0402

R3203 Bottom H 7 0402R CHIPRES 0W06 100K J 0402

R3204 Bottom H 7 0402R CHIPRES 0W06 2K2 J 0402

R3205 Bottom G 8 0402R CHIPRES 0W06 680R J 0402

R3206 Bottom G 8 0402R CHIPRES 0W06 1K2 J 0402

R3300 Bottom P 7 0402R CHIPRES 0W06 4K7 J 0402

R3301 Bottom P 8 0402R CHIPRES 0W06 4K7 J 0402

R3305 Bottom O 7 0402R CHIPRES JUMPER 0R0 0402

R3306 Bottom P 7 0402R CHIPRES 0W06 100R J 0402

R3307 Bottom P 7 0402R CHIPRES 0W06 100R J 0402

R3312 Bottom I 8 0402R CHIPRES 0W06 1K0 J 0402

R3313 Bottom I 8 0402R CHIPRES 0W06 1K0 J 0402

R3314 Bottom O 6 0402R CHIPRES 0W06 47R J 0402

R6005 Bottom N 2 0402R CHIPRES 0W06 100K J 0402

R6020 Bottom T 2 FERRIT_0402 CHIPRES JUMPER 0R0 0402

R6030 Bottom P 2 0402R CHIPRES 0W06 10K J 0402

R6031 Bottom Q 1 0402R CHIPRES 0W06 10K J 0402

R6032 Bottom P 2 0402R CHIPRES 0W06 2R2 J 0402

R6034 Bottom Q 2 0402R CHIPRES 0W06 10K J 0402

R6037 Bottom Q 1 0402R CHIPRES 0W06 100K J 0402

R6100 Bottom G 7 0402R CHIPRES 0W06 100K J 0402

R6101 Bottom G 7 0402R CHIPRES 0W06 10K J 0402

R6102 Bottom H 7 0402R CHIPRES JUMPER 0R0 0402

R6103 Bottom G 6 0402R CHIPRES 0W06 22R J 0402

R6104 Bottom G 7 0402R CHIPRES JUMPER 0R0 0402

R6105 Bottom G 6 0402R CHIPRES JUMPER 0R0 0402

R7001 Bottom T 8 0402R CHIPRES JUMPER 0R0 0402
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Item Side Grid Description and value

R7002 Bottom T 8 0402R CHIPRES JUMPER 0R0 0402

R7501 Bottom R 4 0402R CHIPRES 0W06 2K2 J 0402

R7502 Bottom S 5 0402R CHIPRES 0W06 10K F 0402

R7503 Bottom Q 5 0402R CHIPRES 0W06 4K7 J 0402

R7505 Bottom R 4 0402R CHIPRES 0W06 8K2 F 0402

R7506 Bottom R 5 0402R CHIPRES 0W06 10R J 0402

R7507 Bottom S 5 0402R CHIPRES 0W06 10R J 0402

R7508 Bottom R 4 0402R CHIPRES 0W06 10R J 0402

R7509 Bottom Q 4 0402R CHIPRES 0W06 22K J 0402

R7510 Bottom Q 8 0402R CHIPRES 0W06 15R J 0402

R7522 Bottom Q 8 0402R CHIPRES 0W06 27K J 0402

R7523 Bottom S 8 0402R CHIPRES JUMPER 0R0 0402

R7560 Bottom Q 6 0402R CHIPRES 0W06 100R J 0402

S2401 Bottom O 1 SWITCH_EVQP7A01K
SM SW TACT SPST 12V SIDE KEY
2.2N

S2402 Bottom S 1 SWITCH_EVQP7A01K
SM SW TACT SPST 12V SIDE KEY
2.2N

S2403 Top U 5 SWITCH_EVQP7A01K
SM SW TACT SPST 12V SIDE KEY
2.2N

T7501 Bottom R 3 TRANS_HHM1517A2
TRANSF BALUN 3800 +/- 550MHZ
0805

T7520 Bottom S 9 TRANS_LDB15
TRANSF BALUN 1800+-100MHZ
2X1.25

V2000 Top A 4 BGA_4 ASIP TVS BGA4

V2401 Bottom H 4 SOT_666
TRX2 BIPOLAR 2XPNP 40V 0A1
0W12 SOT666

V2402 Bottom G 5 SOT_666 TRX2+RX4 N 4K7/47K SOT666

V2405 Top G 4 LED_48_21SYGC LED WHITE 140MCD 5MA 0603

V2406 Top G 6 LED_48_21SYGC LED WHITE 140MCD 5MA 0603

V2407 Top C 6 LED_48_21SYGC LED WHITE 140MCD 5MA 0603

V2409 Top C 4 LED_48_21SYGC LED WHITE 140MCD 5MA 0603

V2410 Bottom H 4 SC79
SCH DI 1PS79SB31 200MA 30V
SOD523

V2411 Bottom H 4 SOT_666
TRX2 BIPOLAR 2XPNP 40V 0A1
0W12 SOT666

V2412 Bottom M 1 LED_CL_194WH_D_BIG
LED TOP BLUE 5MA min30mcd
0603 max0.4mm
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Item Side Grid Description and value

V2413 Bottom M 9 LED_CL_194WH_D_BIG
LED TOP BLUE 5MA min30mcd
0603 max0.4mm

X1001 Bottom U 3 CON_24R_JANK_P0.4 CONN BTB 2X12 F P0.4 30V 0.2A

X2000 Bottom A 7
CON_JACK_HR33NK_2DJA_2
S CONN CHR DIA 2.0MM COMPRESS

X2002 Bottom B 3 CON_UX60SC_MB_5ST_1.2L
CONN USB 5POL MINI-USB B TYPE
P0.8

X2030 Bottom B 5 CON_T389093_A1
SMD CONN AUD/VID 4POL 30V 2A,
2.5mm DIA

X2060 Top A 3 TRACEABILITY_PAD
MODULE ID COMPONENT
2.8X1.8X0.3

X2070 Bottom O 3 LYNX_BATT_CONN_H7.0
SM BATTERY CONN 3POL SPR 12V
2A

X2700 Bottom G 3
SIM_CONN_M_SK_2005001
65_H1.7 CONN SIM SM 6POL P2.54 H1.05

X3200 Bottom E 7 MOLEX_RSD_501885 CONN SMC TRANSFLASH MMC

X3300 Bottom P 5 SMIA85 SMIA85 SOCKET

X7000 Bottom T 8 RF_SWITCH_MS_156 SM CONN RF JACK 50R 2W 6GHZ

Z2001 Bottom C 2 FERRITE_0402
FERRITE BEAD 0.6R 600R/100MZ
0402

Z2400 Bottom H 4 BGA24_P0.4_H0.67
ASIP 10-CH LCD FILTER W/ESD
BGA24

Z2401 Top U 4 SWLP_18_2.01X1.66
ASIP 7-CH LCD FILTER W/ESD
BGA18

Z2402 Bottom R 2 SWLP_18_2.01X1.66
ASIP 7-CH LCD FILTER W/ESD
BGA18

Z2700 Bottom H 2 SWLP8_1.21X1.21
ASIP SIM ESD/EMI FILT 400UM
BGA8

Z6030 Bottom R 2 EZFVQ42NM61S
LTCC FILT 2441.75+-41.75MHZ
2.5X2

Z7001 Bottom T 8 DEA101910DT
PHASESHIFTER-60°@1850
GSM850...1900 0402

Z7002 Bottom T 8 DEA101910DT
PHASESHIFTER-60°@1850
GSM850...1900 0402

Z7501 Bottom S 7 FILTER_2.1X1.7_10P_H0.6
DUAL RX SAW FILTER 1800/1900
MHz 2016

Z7503 Bottom Q 6 MODULE_SP_LMZ_137
SAW MODULE TX GSM
850/900MHz 4.5x3.2

Z7504 Bottom R 7 FILTER_2.1X1.7_10P_H0.65
DUAL RX SAW FILTER 850/900
MHz 2016

RM-217; RM-222
Parts and layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –23
Copyright © 2007 Nokia. All rights reserved.



Item Side Grid Description and value

Z7520 Bottom S 7 FERRITE_FBMJ1608
FERRITE BEAD 0R01 28R/100MHZ
0603

Swap units

Table 6 Swap phones

Note: For product codes, please refer to the latest Service bulletin.

Swap phones

EMEA

RM-217 SWAP TRX EURO-C BLKSILVER LATIN

RM-217 SWAP TRX EURO-C FR BLKSILV LATIN

RM-217 SWAP TRX EURO-C TR BLKSILV LATIN

RM-217 SWAP TRX EURO-I UKRAIN BLKSLV CYR

RM-217 SWAP TRX EURO-I RU BLKSILV CYR

RM-217 SWAP TRX MEA-13 BLKSILVER LATIN

RM-217 SWAP TRX EURO-F BLKSILVER HEBREW

RM-217 SWAP TRX EURO-H BLKSILVER GREEK

RM-217 SWAP TRX MEA-1 BLKSILVER ARABIC

Table 7 Lightswap

Note: For product codes, please refer to the latest Service bulletin.

Lightswap

EMEA

RM-217 LIGHTSWAP ENGINE EURO-C

RM-217 LIGHTSWAP ENGINE EURO-C FR

RM-217 LIGHTSWAP ENGINE EURO-C TR LATIN

RM-217 LIGHTSWAP ENGINE EURO-I UKRAI CYR

RM-217 LIGHTSWAP ENGINE EURO-I RU CYR

RM-217 LIGHTSWAP ENGINE MEA-13 LATIN

APAC

RM-217 LIGHTSWAP ENGINE APAC-U

RM-217 LIGHTSWAP ENG APAC-T PHILLIP LAT

China

RM-217 LIGHTSWAP ENGINE APAC-R

RM-217 LIGHTSWAP ENGINE APAC-P

RM-217 LIGHTSWAP ENGINE CHINA-Q HONGKONG
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 Component layouts

Component layout - top (1ywa_32a)
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Component layout - bottom (1ywa_32a)
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 Phoenix installation steps in brief

Prerequisites
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PKD-1 (DK2) dongle

• DKU-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a PKD-1 (DK2) dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

• Update FPS-10 software

Note: There is no need to activate FPS-10.

• Activate SX-4 smart card, if you need tuning and testing functions.

Note: When FPS-10 is used only for product software updates, SX-4 smart card is not needed.
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Results
Phoenix is ready to be used with FPS-10 flash prommer and other service tools.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 2 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer text carefully and click Yes.

Figure 3 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 4 InstallShield Wizard Complete

Next actions
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-10 flash prommer can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55 to
a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can choose
between a total uninstallation or a repair installation in a similar way when choosing to uninstall the
application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 5 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 6 Remove program

The progress of the uninstallation is shown.

3. If the operating system does not require rebooting, click Finish to complete.

Figure 7 Finish uninstallation
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If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .

3. In the following view, select Repair.

Figure 8 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files
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• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Prerequisites
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.

• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.
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2. Click Next.

3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 9 Data package setup information

4. To continue, click Next.

RM-217; RM-222
Service Software Instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 3 –13
Copyright © 2007 Nokia. All rights reserved.



5. Choose the destination folder, and click Next to continue.

Figure 10 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.
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Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 11 InstallShield Wizard Complete

Next actions
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in the
readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 12 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 13 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 14 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 15 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from the
Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 16 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For an FPS-8 flash prommer, choose the following connection settings:

• Media: FPS-8

• PORT_NUM: COM Port where FPS-8 is connected

• COMBOX_DEF_MEDIA: FBUS
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iv For a plain USB connection, choose the following connection settings:

Note: First connect the DKU-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.

6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 17 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 18 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 19 Product support module information (example from RM-1)

 Installing flash support files for FPS-10

Prerequisites
Note: You need to install flash support files for FPS-10 only, if you don’t have the latest Phoenix
available or the flash support files have changed after the latest Phoenix release.

• Flash support files are installed automatically, when you install Phoenix. Use Phoenix packages later than
June 2006.

• Normally it is enough to install Phoenix and the phone-specific data package because the Phoenix
installation always includes the latest flash update package files for FPS-10.

• A separate installation package for flash support files is available, and the files can be updated according
to this instruction, if updates appear between new Phoenix / data package releases

Context
If you are not using a separate installation package, you can skip this section and continue with updating
FPS-10 flash prommer software after installing a new phone data package.
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Steps
1. To begin installation, double- click flash_update_x_yy.exe .

Figure 20 Flash update welcome dialog

If the same version of Flash Update package already exists, and you want to reinstall it, the previous
package is first uninstalled. Restart installation again after that.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If you really want
to downgrade, uninstall newer files manually from Control Panel and then rerun the installation again.

Figure 21 Flash installation interrupted

If an older version exists on your PC and it needs to be updated, click Next to continue installation.
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3. It is highly recommended to install the files to the default destination folder C:\Program Files\Nokia
\Phoenix. Click Next to continue.

Figure 22 Flash destination folder

When installing the flash update files for the first time you may choose another location by selecting
Browse. However, this is not recommended.
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4. To complete the installation procedure, click Finish .

Figure 23 Finish flash update

Next actions
FPS-10 flash prommers must be updated using Phoenix!

 Updating FPS-10 flash prommer software

Steps
1. Start Phoenix Service Software and log in, manage connection correctly for your flash prommer.

2. Choose Flashing→Prommer maintenance .

3. When the new flash update package is installed to the computer you will be asked to update the files to
your Prommer. To update the files, click Yes. Click OK if the computer informs you about an unsafe removal
of the device.

4. Alternatively you can update the FPS-10 flash prommer software by clicking the Update button.
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5. Wait until you are notified that update has been successful; the procedure will take a couple of minutes.
Click OK to close the Update Done window.

Figure 24 Prommer SW update finished

6. If you are using the FPS-10 flash prommer, check that it is detected from the progress info. Check also the
status leds in the FPS-10. The MODE2 led (green), VBAT and POWER leds (red) should be lit. If you are using
LAN connection, the LAN led (yellow) should be blinking.

7. Check that your FPS-10 flash prommer has enough memory. Flashing the SU-18 with FPS-10 needs at least
128 MB of SRAM memory in the prommer.

Figure 25 Prommer maintenance window
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Alternative steps
• You can update FPS-10 SW by clicking the Update button and selecting the appropriate fpsxupd.ini file in

C:\Program Files\Nokia\Phoenix\Flash.

Figure 26 Flash directory window

• All files can be loaded separately to the prommer used. To do this, click the right mouse button in the
Flash box files window and select the file type to be loaded.

More information can be found in Phoenix Help.
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 Service tools

Product specific tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-217; RM-222, refer to various concepts.

FS-47 Flash adapter

For flashing (also dead phones) with SS-64. RF testing and tuning, and
EM calibration on ATO level with SS-62 (mechanical locking concept),
CU-4 supported.

MJ-122 Module jig

MJ-122 is meant for troubleshooting, testing, tuning and flashing on
the engine level (CU-4 supported).

The jig includes an RF interface for GSM and Bluetooth.

The following table shows the attenuation values for galvanic RF
connetion:

• Band Tuning
channel

Attenuation RX Attenuation
TX

GSM850 190 0,1 0,1

GSM900 37 0,1 0,1

GSM1800 700 0,15 0,15

GSM1900 661 0,15 0,15

RJ-148 Soldering jig

RJ-148 is a soldering jig used for soldering and as a rework jig for the
engine module.
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SA-123 RF coupler

SA-123 is an RF coupler for GSM RF testing. It is used together with the
product-specific flash adapter.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-123:

• Nokia 6300 (RM-217)

Band Channel Tx-att. (dB) Rx-att. (dB)

EGSM 900 975 5,6 6

38 5,2 7

124 5,2 7

GSM 1800 512 7,3 10

698 8,2 10

885 8,1 10

GSM 1900 512 8,6 9

661 8,7 7

810 9,1 7

Tx-attenuation tolerance is +/-0.5 dB

Rx-attenuation tolerance is +/-1.0dB

• Nokia 6300b (RM-222)

Band Channel Tx-att. (dB) Rx-att. (dB)

GSM 850 128 8,1 9

190 7,4 9

251 7,7 10

GSM 1800 512 8,6 7

698 8,7 8

885 7,5 6

GSM 1900 512 6,7 8

661 6,1 8

810 6,8 8

Tx-attenuation tolerance is +/-0.5 dB

Rx-attenuation tolerance is +/-1.0dB
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SS-101 Domesheet
alignment jig

The purpose of this tool is to support the placement of a domesheet
to the PWB.

General tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-217; RM-222, refer to various concepts.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.

RM-217; RM-222
Nokia Customer Care Service Tools and Service Concepts

Page 4 –8 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



FLS-4S Flash device

FLS-4S is a dongle and flash device incorporated into one package,
developed specifically for POS use.

FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable
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JBT-9 Bluetooth test and
interface box (sales
package)

The JBT-9 test box is a generic service device used to perform
Bluetooth bit error rate (BER) testing, and establishing cordless FBUS
connection via Bluetooth. An ACP-8x charger is needed for BER testing
and an AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• JBT-9 test box

• Installation and warranty information

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

RJ-93 Rework jig

RJ-93 is used as a rework jig for the engine module.

This stencil takes the front end module (FEM) or power amplifier (PA)
module for spreading the soldering paste to the component. Must be
used together with the ST-40 stencil.

SPS-1 Soldering Paste
Spreader
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SRT-6 Opening tool

SRT-6 is used to open phone covers and B-to-B connectors.

SS-45 Front camera
removal tool

The front camera removal tool SS-45 is used to remove/attach the
front camera module from/to the socket.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

ST-40 rework stencil

ST-40 is a rework stencil and used with RJ-93.
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SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-217; RM-222, refer to various concepts.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.
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DKE-2 Mini-USB cable

USB to mini-USB connector cable.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled operating voltage.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRE-2 Bluetooth cable

The bluetooth cable connects the bluetooth connector of the module
jig to the bluetooth test box JBT-9.
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XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB

 Service concepts

POS (Point of Sale) flash concept

Figure 27 POS flash concept

Type Description

Product specific tools

BL-4C Battery

Other tools

ACP-8 Power adapter

FLS-4S or
FLS-5

POS flash dongle
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Type Description

PC with Phoenix service software

Cables

DKE-2 USB connectivity cable

Flash concept with FPS-10

Figure 28 Basic flash concept with FPS-10

Type Description

Product specific tools

FS-47 Flash adapter

Other tools

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable
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Type Description

USB cable

CU-4 flash concept with FPS-10

Figure 29 CU-4 flash concept with FPS-10

Type Description

Product specific tools

FS-47 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable
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Type Description

USB cable

Module jig service concept

Figure 30 Module jig service concept

Type Description

Phone specific tools

MJ-122 Module jig

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SX-4 Smart card

PC with Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable

XCS-4 Modular cable

RM-217; RM-222
Service Tools and Service Concepts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 4 –17
Copyright © 2007 Nokia. All rights reserved.



Type Description

XRS-6 RF cable

USB cable

GPIB control cable

RF testing concept with RF coupler

Figure 31 RF testing concept with RF coupler

Type Description

Product specific tools

FS-47 Flash adapter

SA-123 RF coupler

Other tools

CU-4 Control unit

SX-4 Smart card

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

Measurement equipment

PC with Phoenix service software
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Type Description

Cables

PCS-1 Power cable

XCS-4 Modular cable

XRS-6 RF cable

GPIB control cable

USB cable

Service concept for RF testing and RF/BB tuning

Figure 32 Service concept for RF testing and RF/BB tuning

Type Description

Product specific tools

MJ-122 Module jig

Other tools

CU-4 Control unit

SX-4 Smart card

Measurement equipment

Smart card reader
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Type Description

PC with Phoenix service software

Cables

DAU-9s MBUS cable

PCS-1 DC power cable

PKD-1/PK-1 SW security device

XRS-6 RF cable

GPIB control cable

USB cable
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 Baseband troubleshooting overview
This section is intended to be a guide for localising and repairing electrical faults.

The table below tells you what troubleshooting to go to.

Problem Troubleshooting

Abnormal current consumption 1 General power checking (page 6–6)

2 Battery current measuring fault (page 6–7)

Flashing does not work or the problem is not clearly
defined

1 Flashing (page 6–15)

2 Clocking (page 6–9)

3 Combo memory (page 6–14)

Charging does not work Charging (page 6–8)

Display does not work Display fault (page 6–20)

Backlights do not work 1 Backlight (page 6–23)

2 LED driver (page 6–8)

Reminder LEDs do not work Reminder LED (page 6–24)

USB does not work USB (page 6–43)

Audio (mic, earpiece, IHF) does not work 1 Audio (page 6–26)

2 Acoustics (page 6–26)

Camera does not work 1 Camera baseband hardware (page 6–11)

2 Camera viewfinder (page 6–12)

3 Bad image quality (page 6–13)

Bluetooth does not work Bluetooth (BT) (page 6–37)

FM radio does not work FM radio (page 6–17)

MicroSD card does not work MicroSD card (page 6–18)
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 Power and charging troubleshooting

General power checking troubleshooting

Troubleshooting flow
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Battery current measuring fault troubleshooting

Troubleshooting flow
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Charging troubleshooting

Troubleshooting flow
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Clocking troubleshooting

Troubleshooting flow
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 Interface troubleshooting

Camera failure

Introduction to camera troubleshooting
Bad conditions often cause bad pictures. Therefore, the camera operation has to be checked in constant
conditions or by using a second, known-to-be-good Nokia device as reference. Image quality is hard to
measure quantitatively, and the difference between a good and a bad picture can be small. Some training
or experience may be needed to detect what is actually wrong.

When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
are common:

• Dust (black spots)

• Lack of sharpness

• Bit errors

Taking and evaluating test pictures
When taking a test picture, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• If the phone is hot, let it rest for a while before taking the picture

• Make sure the optical system is clean

• Use highest possible resolution

• Make sure the light is suffiecient (bright office lightning)

• Do not take the picture towards light source

• Be as still as possible when taking the picture

• Distance should be at least 40cm, 1-2m is recommended

When evaluating a test picture, remember the following:

• The center of the picture is sharper than the edges

• The image may be blurred, though it does not show in the viewfinder

• Analyse the picture from your PC monitor, full colour setting is recommended

• If possible, compare with a picture of the same motive taken with a similar Nokia device
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Camera hardware troubleshooting

Troubleshooting flow
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Camera viewfinder troubleshooting

Troubleshooting flow
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Camera: Bad image quality troubleshooting

Troubleshooting flow
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COMBO memory troubleshooting

Troubleshooting flow
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Flash programming fault troubleshooting

Part 1
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Part 2

Figure 33 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.

Figure 34 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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FM radio troubleshooting

Troubleshooting flow
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MicroSD card troubleshooting

Context
In the RM-217/222 the microSD card reader is located under the battery cover.

Figure 35 Location of the microSD card reader in RM-217/222
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Troubleshooting flow
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Take single trig measurement on the rising edge of the DAT signal.
Figure 36 SD card initialization from pin J3206

 User interface troubleshooting

Display module troubleshooting

General instructions for display troubleshooting

Context
The RM-217/222 has three display modes:

• Normal mode: The display is in normal mode when the phone is in active use.

• Partial idle mode: The display is in partial idle mode when the power saver is on.

• Sleep mode: The display has a sleep mode to conserve power. In this mode the display looks blank, but
the phone is switched on. To verify if the phone display is sleeping, press a key.

The operating modes of the display can be controlled with the phone settings menu.

Table 8 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.
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Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 9 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.

Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display troubleshooting

Troubleshooting flow
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Backlight troubleshooting

Context
The device has one LED driver that provides current for both the display and keyboard backlights. Brightness
can be adjusted manually, and it affects both the display and keypad. Keyboard backlights can be turned ON/
OFF separately but not without switching on the display lights.

Display and keyboard backlight troubleshooting
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Reminder LED troubleshooting

Troubleshooting flow
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LED driver troubleshooting

LED driver troubleshooting
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 Audio troubleshooting

Introduction to acoustics troubleshooting
Note: Always make sure all openings are clean and all contact pads are intact and make contact. If
audio still does not work, please continue to the electronic audio troubleshooting (2nd diagram
where applicable).

Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by speaker(s). The acoustics of the phone includes three basic systems: earpiece,
Integrated Hands Free (IHF) and microphone.

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speaker radiates from a single sound hole located 3 cm below the power key.
The microphone is located at the hinge, next to the system connector.

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.

Audio troubleshooting test instructions
Differential internal earpiece outputs can be measured either with a single-ended or a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be single-ended.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Current probe (Internal handsfree PWM output measurement)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.
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The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input
terminal

Output
terminal

Path
gain
[dB]

(fixed)

Input
voltage
[mVp-p]

Differe
ntial

output
voltage
[mVp-

p]

Outp
ut DC
level
[V]

Output
current

[mA]

External Mic to
External Earpiece

XMICP and
GND

HSEAR R
and GND

-2.9 1000 720 1.2 NA

HSEAR L and
GND

External Mic to
Internal Earpiece

XMICP and
GND

EarP and
GND

-4.0 750 490 1.2 NA

EarN and
GND

External Mic to
Internal handsfree

XMICP and
GND

E2101 pad 8.5 920 2520 0 25mA
(calc.)E2102 pad

Internal Mic to
External Earpiece

B2100 (OUT/
GND)

HSEAR R
and GND

22.7 100 1360 1.2 NA

HSEAR L and
GND

Measurement data

Figure 37 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.
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Figure 38 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.

Figure 39 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Earpiece troubleshooting

Troubleshooting flow
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Internal earpiece troubleshooting

Troubleshooting flow
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External headset earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow

RM-217; RM-222
BB Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –33
Copyright © 2007 Nokia. All rights reserved.



Microphone troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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External headset microphone troubleshooting

Troubleshooting flow
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 Connections troubleshooting

Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth (BT) problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the BT antenna to become loose or partially
detached from the PWB.

A malfunction in the BT ASIC, BB ASICs or the phone’s
BT SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component. For location of the antenna, please refer to the
exploded view in the Parts and layouts section.

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.
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Figure 40 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST

RM-217; RM-222
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –38 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



7. To run the tests, click Start.

Figure 41 Bluetooth self tests in Phoenix

Bluetooth BER failure troubleshooting

Context
Basic encoding rules, BER, is a self-identifying and self-delimiting encoding scheme, which means that each
data value can be identified, extracted and decoded individually.
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Part 1: Bluetooth self test passed but BER test failed
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Part 2: Bluetooth self test failed
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Bluetooth audio and UI activation troubleshooting

Troubleshooting flow
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USB interface troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart card
reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 10 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to RF troubleshooting
On the following pages you will find a step-by-step troubleshooting procedure and reference measurements
at the relevant signal points. For functional descriptions, please refer to the System module section.

Notes on reference measurements
All measurements must be done using:

• spectrum analyser with a high-frequency high-impedance passive probe (LO-/reference frequencies and
RF power levels)

• oscilloscope with a 10:1 probe (DC-voltages and low frequency signals)

Important: All measurements with an RF coupler must be performed in an RF shielded environment,
or where there are no transmissions on the same frequencies. This may disturb sensitive receiver
measurements.

Repairing this phone - important
The RF section of the phone is built around one RF ASIC. Before changing the RF ASIC, please make sure that
supply voltages and serial communication coming from baseband to RF are OK.

Please note that the grounding of the FEM module is directly below the FEM module. Therefore, it is difficult
to check or change the module.

Most RF semiconductors are static discharge sensitive! ESD protection must be taken care of during repair
(ground straps and ESD soldering irons). The RF ASIC and FEM are moisture sensitive, so parts must be pre-
baked prior to soldering.

In addition to key components, there are lot of discrete components (resistors, inductors and capacitors)
which troubleshooting is done mainly by checking if the soldering of the component is done properly.

Capacitor can be checked for shorts and resistors for value by means of an ohmmeter, but be aware in-circuit
measurements should be evaluated carefully.

Keep in mind that all measured voltages or RF levels depicted in the service manual are rough figures.
Especially RF levels vary because of different measuring equipment or different grounding of the probe used.

When using an RF probe, use a pair of metallic tweezers to connect the probe ground to the PWB ground as
close to the measurement point as possible. If measurements are performed in a product specific module
jig, then “GND” pads should be used for the probe ground.

Supported bands
The following part of the service manual contains a description of all four GSM bands. It covers both variants,
RM-217 and RM-222. Both variants support three GSM bands as follows:

• RM-217: GSM900, GSM1800, GSM1900

• RM-222: GSM850, GSM1800, GSM1900

Make sure to investigate only the bands, which the phone is made for.
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 RF key components

Figure 42 RF key components, bottom side main board

 Receiver troubleshooting

Introduction to RX troubleshooting
Rx can be tested by making a phone call or in the local mode. For the local mode testing, use Phoenix service
software.

The main Rx troubleshooting measurement is RSSI measurement. This test measures the signal strength of
the received signal. I and Q branches can be measured separately.
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In GSM, the input signal can be either a real GSM signal or a CW signal that is 67.771kHz up from the carrier
frequency.

For service tool usage instructions, refer to section Service Tools and Service Concepts.

General instructions for RX troubleshooting

Steps
1. Connect a test jig to a computer with a DAU-9S cable or to a FPS-10 flash prommer with a modular cable

(XCS-4).

Make sure that you have a PKD-1 dongle connected to the computer's parallel port.

2. Connect CU-4 with 12 V supply. The DC supply voltage is set to 3.7 V by default (in Phoenix).

3. Connect an RF cable between the RF connector of the module test jig (MJ-122) and measurement
equipment or alternatively use a 50 Ω (at least 2 W) dummy load in the module test jig RF connector,
otherwise the RF part may be damaged.

Note: Make sure that all connections are made to the correct RF connector.

4. Set Rx on.

i Set the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone. (With the FPS-10 prommer use FPS10_USB or FPS10_TCP drivers,
depending on connection type. When using DAU-9S select FBUS).

iii From the File menu, choose product: File -> Choose Product -> xx-x* (* = type designator of the
phone, eg. RM-217/222), or press Ctrl + R to scan product.

iv From the toolbar, set operating mode to “Local”.

5. EGSM850/900/1800/1900 troubleshooting

i From the Testing menu, activate the RF Controls window:  Testing -> GSM -> RF Controls .

ii In the RF Controls window:

• Select band.

• Set Active unit to “Rx” (Default ).

• Set Operation mode to “Burst” (Default).

• Set Rx/Tx channel (see table below).

• Apply a frequency (see table below) to the RF-connector.

Note: Remember to compensate for cable attenuation, specific for MJ-122. You will find the values
in the Service tools section.

Apply a signal to the RF-connector (remember to compensate for cable attenuation). See values in
the table below.
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Band Channel (RX and
TX)

Input frequency
(MHz)

Offset (kHz) Power level
(dBm)

GSM850 190 881.66771 67.710 -90

GSM900 37 942.46771 67.710 -90

GSM1800 700 1842.86771 67.710 -90

GSM1900 661 1960.06771 67.710 -90

Figure 43 RF Controls window

Receiver (RX) troubleshooting

Context
Troubleshoot one band at a time. Start with GSM850 (RM-222) or GSM900 (RM-217), and end with GSM1900.

Receiver troubleshooting
Apply a signal according to the table in General instructions for RX troubleshooting (page 7–7)
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GSM Rx chain activation for manual measurements / GSM RSSI measurement

Context
RSSI signal measurement is the main Rx troubleshooting measurement. The test measures the strength of
the received signal.

I and Q branches can be measured separately. In GSM, the input signal can be either a real GSM signal or a
CW (Continuous Wave) signal that is 67.771 kHz above the carrier frequency.

Steps
1. Start Phoenix service software.

2. Choose Testing→GSM→RSSI Reading .

3. Set the RF signal generator for a channel frequency +67.771 kHz in CW mode with a –80 dBm signal level.

Alternatively set the cellular tester downlink channel to the appropriate channel. Make sure that the tester
is set to continuous mode, not to burst mode.

4. In the RSSI Reading window, select the appropriate band and channel.

Figure 44 RSSI Reading window

5. To start the measurement, activate GSM Rx chain, click Start.

Results
RSSI reading values of the selected band and channel are displayed. The RSSI level must be the same value
as that which is set at the signal generator (-80 dBm).

 Transmitter troubleshooting

General instructions for TX troubleshooting

Context
• Tx troubleshooting requires Tx operation.

• Do not transmit on frequencies that are in use!

• Transmitter can be controlled in the local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is "RF Controls".
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• Tx IQ tuning and Tx power tuning can be also used in some cases.

• Remember that retuning is not a fix! Phones are tuned correctly in production.

The first set of steps instructs how to assemble the test setup. This setup is general for all Tx troubleshooting
tasks.

Alternative steps provide specific troubleshooting instructions for Phoenix service software.

Caution: Never activate the GSM transmitter without a proper antenna load. There should be always
50 Ω load connected to the RF connector (antenna, RF-measurement equipment or at least 2 W
dummy load), otherwise the GSM Power amplifier may be damaged.

Steps
1. Connect a test jig to a computer with a DAU-9S cable or to a FPS-10 flash prommer with a modular cable

(XCS-4).

Make sure that you have a PKD-1 dongle connected to the computer's parallel port.

2. Connect CU-4 with 12 V supply. The DC supply voltage is set to 3.7 V by default (in Phoenix).

3. Connect an RF cable between the RF connector of the module test jig (MJ-122) and measurement
equipment or alternatively use a 50 Ω (at least 2 W) dummy load in the module test jig RF connector,
otherwise GSM may be damaged.

Note: There are two antenna connectors in the module jig:

• one for GSM

• one for Bluetooth

Make sure that all connections are made to the correct RF connector.

Normally a spectrum analyser is used as measurement equipment.

Note: The maximum input power of a spectrum analyser is +30 dBm.

To prevent any damage, it is recommended to use 10 dB attenuator on the spectrum analyzer input.

4. Set Tx on.

i Set the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone. (With the FPS-10 prommer use FPS10_USB or FPS10_TCP drivers,
depending on connection type. When using DAU-9S select FBUS driver).

iii From the File menu, choose product: File -> Choose Product -> xx-x* (* = type designator of the
phone, e.g. RM-217/222), or pressCtrl + R to scan product.

iv From the toolbar, set operating mode to “Local”.

5. GSM850/900/1800/1900 troubleshooting

i From the Testing menu, activate the RF Controls window:  Testing -> GSM -> RF Controls .

ii In the RF Controls window:

• Select band "GSM850", “GSM900” or “GSM1800” or “GSM1900”.

• Set Active unit to “Tx” (Default = “Rx”).
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• Set Operation mode to “Burst” (Default).

• Set Tx data type to “All1” (Default).

• Set Rx/Tx channel (see table below)

• Set Edge to “Off” (Default).

• Set Tx PA mode to “High” (Default).

• Set power level (see table below)

Band Channel (RX and TX) TX power level

GSM850 190 5

GSM900 37 5

GSM1800 700 0

GSM1900 661 0

Figure 45 RF Controls window
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Transceiver (TX) troubleshooting

Troubleshooting flow
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Checking antenna functionality

GSM antenna
In the GSM antenna, there is one feed and two GND contacts.

Between GND1 and Feed, a DC short-circuit can be measured.

GND2 has no DC connection to the other contacts.

The antenna is functioning normally, if the contact pads hit the antenna C-clips on the PWB and the antenna
is visually intact.

BT antenna
The BT antenna is (as the GSM antenna) placed on the flex foil on the antenna module. It has one feed and
one short contact. The antenna is functioning normally, if the contact pads hit the antenna C-clips on the
PWB and the antenna is visually intact.

Figure 46 Location of the GSM and BT antenna C-clips on the PWB
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Figure 47 GSM and BT antenna contact pads on the antenna module

Antenna C-clips
When checking the antenna functionality, you can also check that the antenna C-clips are intact (that is, there
are no cracks/bends in them).

Figure 48 Antenna C-clips on the PWB
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 Synthesizer troubleshooting

Synthesizer troubleshooting
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 RF tunings

Introduction to RF tunings
Important: Only perform RF tunings if:

• one or more of the RF components have been replaced

• flash memory chip is replaced or corrupted.

RF calibration is always performed with the help of a product-specific module jig (MJ-122), never with an RF
coupler. Using an RF coupler in the calibration phase will cause a complete mistuning of the RF part.

Important: After RF component replacements, always use autotuning. Manual tunings are only
required in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken into account when the phone is tuned. As
all RF losses are frequency dependent, the user has to act very carefully and understand the measurement
setup.

For RF attenuations of the module jig, please refer to the Service tools section.

Auto tuning for BB5.0
This phone can be tuned automatically.

Autotune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• Power supply

• Product specific module jig

• Cables: XRF-1 (RF cable), USB cable, GBIP cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 49 Auto tuning concept with CMU200
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Phoenix preparations
Install the phone specific data package, for example RM-217/222_dp_1.78_sw_sh3.26.exe. This defines phone
specific settings..

Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2 To go to autotune, select Tuning (Alt-U) > Auto-Tune (Alt-A) from the menu.

3 Start autotuning, clicking the Tune button.

 System mode independent manual tunings

RF channel filter calibration

Context
Rf channel filter calibration tunes the internal low pass filters of the RF ASIC, that limit the bandwidth of BB
IQ signals.

Table 11 Rf channel filter calibration tuning limits

Min Typ Max

Tx filter 0 10 31

RX mixer 0 13 31

Rx filter 0 16 31

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Rf Channel Filter Calibration .

3. Click Tune.

4. To save the values to the PMM (Phone Permanent Memory) area, click Write.

5. To close the Rf Channel Filter Calibration window, click Close.

Results

Figure 50 Rf channel filter calibration typical values
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PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .

3. Click Tune.

4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

 GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Rx Calibration .
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5. Click Start.

6. Connect the signal generator to the phone, and set frequency and amplitude as instructed in the
Rx Calibration with band EGSM900 (step 1-3) pop-up window.

Important: The calibration uses a non-modulated CW signal. Increase the signal generator level by
cable attenuation and module jig probe attenuation.
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7. To perform the tuning, click OK.

8. Check that the tuning values are within the limits specified in the following table:

Table 12 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM850

AFC Value (init) -200 -80..40 200 -

AFC slope 0 108..121 200 -

RSSI (AGC-0) 106 107..110 114 dB

GSM900

AFC Value (init) -200 -105..62 200 -

AFC slope 0 122 200 -

RSSI (AGC-0) 106 107...110 114 dB

GSM1800

RSSI (AGC-0) 105 105...109 114 dB

GSM1900

RSSI (AGC-0) 105 105...109 114 dB
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9. Click Next to continue with GSM1800 Rx tuning.

Next actions
Repeat steps 6 to 9 for GSM1800 and GSM1900

Rx band filter response compensation (GSM)

Prerequisites
Rx calibration must be performed before the Rx band filter response compensation.

Context
On each GSM Rx band, there is a band filter in front of the RF ASIC front end. The amplitude ripple caused by
these filters causes ripple to the RSSI measurement, and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.
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4. Select GSM850 or GSM900 band.

5. Choose Tuning→GSM→Rx Band Filter Response Compensation .

6. Select Tuning mode: manual

7. Click Start.

8. Connect the signal generator to the phone, and set frequency and amplitude as instructed in the Rx Band
Filter Response Compensation for EGSM850/EGSM900 pop-up window, step 1-3.
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9. To perform tuning, click OK.

10. Go through all 9 frequencies. The following table will be shown:

11. Check that the tuning values are within the limits specified in the following table:

Min Typ Max Unit

GSM850

Ch. 118/867.26771 MHz -6 -1 2 dB

Ch. 128/869.26771 MHz -3 0 2 dB

Ch. 140/871.66771 MHz -3 0 2 dB

Ch. 172/878.06771 MHz -2 0 2 dB

Ch. 190/881.66771 MHz -2 0 2 dB

Ch. 217 / 887.06771 MHz -2 0 2 dB

Ch. 241/891.86771 MHz -3 0 2 dB

Ch. 251/893.86771 MHz -3 0 2 dB

Ch. 261/895.86771 MHz -6 -1 -2 dB

GSM900

Ch. 965 / 923.26771 MHz -6 -1 2 dB

Ch. 975 / 925.26771 MHz -3 0 2 dB

Ch. 987 / 927.66771 MHz -3 0 2 dB

Ch. 1009 / 932.06771 MHz -2 0 2 dB
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Min Typ Max Unit

Ch. 37 / 942.46771 MHz -2 0 2 dB

Ch. 90 / 953.06771 MHz -2 0 2 dB

Ch. 114 / 957.86771 MHz -3 0 2 dB

Ch. 124 / 959.86771 MHz -3 0 2 dB

Ch. 136 / 962.26771 MHz -6 -1 2 dB

GSM1800

Ch. 497 / 1802.26771 MHz -6 -1 3 dB

Ch. 512 / 1805.26771 MHz -3 0 3 dB

Ch. 535 / 1809.86771 MHz -3 0 3 dB

Ch. 606 / 1824.06771 MHz -3 0 3 dB

Ch. 700 / 1842.86771 MHz -3 0 3 dB

Ch. 791 / 1861.06771 MHz -3 0 3 dB

Ch. 870 / 1876.86771 MHz -3 0 3 dB

Ch. 885 / 1879.86771 MHz -3 0 3 dB

Ch. 908 / 1884.46771 MHz -6 -1 3 dB

GSM1900

Ch. 496 / 1927.06771 MHz -6 -1 2 dB

Ch. 512 / 1930.26771 MHz -3 0 2 dB

Ch. 537 / 1935.26771 MHz -3 0 2 dB

Ch. 586 / 1945.06771 MHz -3 0 2 dB

Ch. 661 / 1960.06771 MHz -3 0 2 dB

Ch. 736 / 1975.06771 MHz -3 0 2 dB

Ch. 794 / 1986.66771 MHz -3 0 2 dB

Ch. 810 / 1989.86771 MHz -3 0 2 dB

Ch. 835 / 1994.86771 MHz -6 -1 2 dB

12. If the values are within the limits, click Next to continue to the next band.

Next actions
Repeat the steps 8 to 12 for GSM1800 and GSM1900.

 GSM transmitter tunings

Tx IQ tuning (GSM)

Context
The Tx path branches to I and Q signals at RF I/Q modulator. Modulator and analog hardware located after
it cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning balances the I and Q
branches.
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Tx IQ tuning must be performed for all GSM bands.

Steps
1. Start Phoenix service software.

2. From the Operating mode drop-down menu, set mode to Local.

3. Choose Tuning→GSM→Tx IQ Tuning .

4. Select Mode: Automatic.

5. Select band GSM850 or GSM900 and click Start.

6. Click Next to start GSM1800 band TX IQ tuning.

7. Click Next to start GSM1900 band TX IQ tuning.

8. ClickFinish and then Close.

Next actions
Tuning sliders should be close to the center of the scale after the tuning and within the limits specified in
the following table. If they are not within the limits, check Tx IQ quality manually.

Min Typ Max Unit

GSM850

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 °

GSM900
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Min Typ Max Unit

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 °

GSM1800/GSM1900

I/Q DC -6 0.5 6 %

Ampl -1 0 1 dB

Phase 95 100 110 °

Tx power level tuning (GSM)

Context
Because of variations at the IC (Integrated Circuit) process and discrete component values, the actual
transmitter RF gain of each phone is different. Tx power level tuning is used to find out mapping factors
called 'power coefficients’. These adjust the GSM transmitter output power to fulfill the specifications.

For EDGE transmission, the bias settings of the GSM PA are adjusted in order to improve linearity. This affects
the PA gain and hence the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a spectrum analyzer.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx Power Level Tuning .
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5. Click Start.l

6. Set the spectrum analyzer for power level tuning:

Frequency Channel frequency:

• 836.6 MHz GSM850

• 897.4MHz GSM900

• 1747.8MHz GSM1800

• 1880MHz GSM1900

Span 0 Hz

Sweep time 2ms

Trigger Video triggering (-10dBm)
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Resolution BW 3MHz

Video BW 3MHz

Reference level offset sum cable attenuation with module jig
attenuation

Reference level 33dBm

A power meter with a peak power detector can be also used. Remember to take the attenuations into
account.

7. Adjust power for all bold power levels to correspond the Target dBm column by pressing + or – keys.

8. If all bold power levels are adjusted, click Next to continue with GSM850 EDGE.

9. Adjust power for all bold power levels to correspond the Target dBm column by pressing + or – keys.

Next actions
Continue tuning the bold power levels of the GSM900, GSM1800 and GSM1900 bands. You will see this
message, if finished successfully:
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 Phone description

Introduction
This chapter describes the system module including engine, power management, interfaces, audio etc.

The baseband is based on BB5.0 with a RAPGSM main processor and Retu/Tahvo energy management. All
blocks that require high voltage process are in Tahvo and all other in Retu. The RF part is based on the ASIC
Ahne.

RM-217/222 is a monoblock phone, in which all electrical components are assembled into one PWB.

RM-217 operates on the GSM 900/1800/1900 bands.

RM-222 operates on the GSM 850/1800/1900 bands.

Key components

Function Name Item

Energy management Retu

Tahvo

D2200

N2300

Main processor RAPGSM D2800

Memory Combo: 128 Mbit SDRAM & 256 Mbit NOR flash D3000

RF ASIC Ahne N7505

Front end module Power amplifier and Antenna Switch N7520

Antenna Antenna module assembly

• RM-217: 900/1800/1900 MHz

• RM-222: 850/1800/1900 MHz

System connector AV connector

mini USB connector

X2030

X2002

Battery BL-4C, 3.7 V, 860 mAh

Bluetooth BC4-ROM N6030

FM radio TEA5760 N6100

IHF Speaker Donau or Aura (in antenna module assembly)

Earpiece RDF-07A 32OHM 10.86x7.40.2.2 B2101

Microphone Clapton B2100

Vibra SMD VIBRA MOTOR M2100

Charger connector 2 mm Nokia charger interface X2000

Camera 2.0 Mpix SMIA85

HWA STV0984N D3300

Display QVGA 240 x 320, 2"

LED driver TPS 61061 YZFR N2301

RTC battery 311 size G2200
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PWB overview
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System block diagram

Figure 51 System block diagram
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Board and module connections

Figure 52 Board and module connections

 Engine

Engine modules
The engine contains

• RF module with Ahne ASIC

• Main processor with integrated memory (Baseband)

• Energy management - Retu and Tahvo (Baseband)
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• SDRAM and NOR flash memories

RF engine
The RF module performs the high frequency operations of the engine for GSM. In both transmitter and
receiver, the modulator and demodulator operate at the channel frequency.

The core components of the RF module are:

• Ahne RF ASIC (application specific integrated circuit)

• Front end module (FEM) module (Power amplifier and Antenna switch)

The RF engine also includes:

• Voltage controlled oscillators (VCO and VCTCXO)

• SAW filters

The baseband section controls the RF module through the serial bus, RFBus. This passes information about
eg. frequency band and mode of operation. Ahne RF ASIC controls the mode of operation, and further sends
control signals to the front end module.

In addition to the RFBus there are other interface signals for the power control loop, VCTCXO control and for
the modulated waveforms.

Main processor
The main processor in this device is RAPGSM, a BB5.0 ASIC.

Some of its interfaces, processors and controllers are:

• General purpose UARTs

• Processor modules

• I2C (between ICs) interface

• GSM coder

• Interfaces to user interface, SIM and MMC

• Accessory interface

• Handling of RF-BB interface

• I/O voltage = 1.8 V, Core voltage <1.8 V

Energy management
Two ASICs manages the energy in the phone; Retu and Tahvo. Together they cover the analogue audio and
energy management function needs.

Tahvo
All blocks that need a special silicon process are included in Tahvo.

Tahvos main features are:

• Energy management control

• Supply voltage generation

• Charge control

• Digital core supply

• Current control for LED supply

Retu
The blocks that do not have special needs are included in Retu.

Retu controls for example:
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• Audio block

• SIM

• FM radio

Modes of operation
The functional behavior can be divided into seven different states. Each of these states will affect the general
functionality of the phone:

• No supply

• Backup

• Power off

• Reset

• Power on

• Deep sleep

 Battery and charging

Battery
• Type: BL-4C, Li-Ion

• Capacity: 860 mAh

• BSI resistor nominal value: 75 kΩ

Battery temperature is measured on the NTC on the main board.

Battery connector
The battery connector has three poles:

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Charging
This phone is charged through the smaller Nokia standard interface (2.0 mm plug). The old standard charger
(3.5 mm) can be used together with the CA-44 charger adapter.
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Figure 53 Old (left) and new (right) charger plugs

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

 Interfaces

FM radio
This phone uses a single-chip electronically tuned FM stereo radio with low voltage application.

Figure 54 FM radio interface

Camera

Camera interface
The RM-217/222 has a 2.0 Megapixel camera, supported by a hardware accelerator.
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SIM
The SIM interface is the electrical interface between the SIM card and the mobile phone engine.

The data communication between the SIM card and the phone is asynchronous half duplex.

Figure 55 SIM interface connections

SIM Logic level shifting
The SIM interface can support 3V and 1.8V SIM cards.

SIM Power up/down
The SIM power up/down sequence is generated in Retu. This means that Retu generates the reset switch
(RST) signal to the SIM. In addition, the SIMCardDet signal is connected to Retu.

The SIM interface is powered up when the SIMCardDet signal indicates “card in”.
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µSD card interface

The µSD card is connected to the engine by an external level shifter and ESD protection filter. Supplied
voltages:

• VMMC: 2.85 V (from level shifter)

• VIO: 1.8 V (from Retu)

The card removal is detected by a push detect switch.

 User interface

Display
The display unit comprises a parallel interface.

Keyboard
All keys are placed on the main PWB.

• Numeric keys

• Navigation key, Soft keys, Start, and End

• Power switch

• Volume up and down switch

Display and keypad backlight
There are two sets of LEDs illuminating the display and the keypads:

• Display LEDs, 4pcs

• Main keypad on PWB, 4 pcs, white colour

All sets share the same driver. None of the keypads can be illuminated without the LCD backlight being turned
on.

Reminder lights
Two additional blue LEDs serve as reminder lights for missed calls/text messages.

 Audio concept

Audio concept
The functional core of the audio hardware is built around two ASICs; RAP engine and Retu.

Retu provides an interface for the trancducers and the AV connector.
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There are three audio transducers:

• 1 dynamic earpiece

• 1 dynamic speaker

• 1 microphone module

Retu also provides an output for the vibra motor.

All external audio accessories are connected to the specific audio connector.

Figure 56 Audio block diagram

Internal audio
The internal audio components are used in these modes:

Hand portable (HP) mode Internal hands free (IHF) mode

Microphone X X

Earpiece X

Speaker X
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 Connections

AV connector
Headsets and other galvanic accessories are connected to the specific audio input. The accessory mode is
automatically enabled/disabled when a dedicated accessory is connected/disconnected.

Note: When testing external audio through the audio connector, make sure that the specific
accessory can be used with this phone!

USB
USB (Universal Serial Bus) provides a wired connectivity between a PC and peripheral devices. It is a differential
serial bus.

USB 2.0 is supported with full speed (12 Mbps).

Hot swap is supported, which means that USB devices may be plugged in/out at any time.

This phone is provided with a specific connector for mini USB.

Bluetooth
Bluetooth provides a fully digital link for communication between a master unit and one or more slave units.

This bluetooth solution is a single chip solution.

Bluetooth connects to RAPGSM on the GENIO and GPIO busses.

The Bluetooth module is provided with power from VBat.

Figure 57 Bluetooth interface block diagram
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 Technical specifications

General specifications

Unit Dimension (mm) Weight (g) Volume (cc)

Transceiver with BL-4C
860 mAh Li-Ion battery
pack

106,8 x 43,8 x 13,1 91 55,6

Battery endurance

Battery Talk time Standby time Music time

BL-4C 860 mAh Li-ion 3 - 3.5 hours Up to 300 hours > 10 hours

Note: Variation in operation times will occur depending on SIM card, network settings and usage.
Talk time is increased by up to 30% if half rate is active, and reduced by 5% if enhanced full rate is
active.

Environmental conditions

Temperature

Temperature range Min oC Max oC

Operational (all specs met) -5 +55

Functional (reduced
performance)

-30 +70

Storage -30 +85

The HW module complies with the SPR4 Operating Conditions.

Humidity
Relative humidity range is 5...95%.

The hardware module is not protected against water. Condensed or splashed water might cause malfunction.
Any submerge of the phone will cause permanent damage. Long-term high humidity, with condensation,
will cause permanent damage because of corrosion.

The hardware module complies with the SPR4 Operating Conditions.

Electrical characteristics

Table 13 Normal and extreme voltages

Voltage Voltage (V) Condition

General conditions

Nominal voltage 3.7

Lower extreme voltage 3.06 a
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Voltage Voltage (V) Condition

Higher extreme voltage 4.2 b

a. ADC settings in the SW might shutdown the phone above this value.

b. During fast charging of an empty battery, this voltage might exceed this value. Voltages between 4.20 and
4.60 might appear for a short while.

Main RF characteristics

Table 14 Channel numbers and frequencies

System Channel number TX frequency RX frequency Unit

GSM850 128 <= n <= 251 F = 824.2 + 0.2*(n -
128)

F = 869.2 + 0.2*
(n-128)

MHz

GSM900 0 < =n <= 124 F = 890 + 0.2*n F = 935 + 0.2*n MHz

975 <= n <= 1023 F = 890 + 0.2* (n -
1024)

F = 935 + 0.2*(n
-1024)

MHz

GSM1800 512 <= n <= 885 F = 1710.2 + 0.2* (n -
512)

F = 1805.2 + 0.2*
(n-512)

MHz

GSM1900 512 <= n <= 810 F = 1850.2 + 0.2* (n -
512)

F = 1930.2 + 0.2*
(n-512)

MHz

Table 15 Main RF characteristics

Parameter Unit and value

Cellular systems RM-217: EGSM900/GSM1800/GSM1900

RM-222: GSM850/GSM1800/GSM1900

RX Frequency range GSM850: 869 ... 894 MHz

EGSM900: 925 ... 960 MHz

GSM1800: 1805...1880 MHz

GSM1900: 1930...1990 MHz

TX Frequency range GSM850: 824 ... 849 MHz

EGSM900: 880 ... 915 MHz

GSM1800: 1710 ...1785 MHz

GSM1900: 1850...1910 MHz

Duplex spacing GSM850: 45 MHz

EGSM900: 45 MHz

GSM1800: 95 MHz

GSM1900: 80 MHz

Channel spacing 200 kHz
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Parameter Unit and value

Number of RF channels GSM850: 124

EGSM900: 174

GSM1800: 374

GSM1900: 300

Output Power GSM850: GSMK 5...33 dBm

GSM850: 8-PSK 5...26.5 dBm

EGSM900: GSMK 5...33 dBm

EGSM900: 8-PSK 5...26.5 dBm

GSM1800: GSMK 0...30 dBm

GSM1800: 8-PSK 0...25.5 dBm

GSM1900: GSMK 0...30 dBm

GSM1900: 8-PSK 0...25.5 dBm

Number of power levels GMSK GSM850: 15

EGSM900: 15

GSM1800: 16

GSM1900: 16

Number of power levels 8-PSK GSM850: 12

EGSM900: 12

GSM1800: 14

GSM1900: 14

Table 16 Transmitter characteristics

Item Values

Type Direct conversion, nonlinear, FDMA/TDMA

LO frequency range GSM850: 3296...3576 MHz (4 x TX freq)

EGSM900: 3520...3660 MHz (4 x TX freq)

GSM1800: 3420...3570 MHz (2 x TX freq)

GSM1900: 3700...3820 MHz (2 x TX freq)

Output power

(GSM850/EGSM900/GSM1800/
GSM1900)

GMSK 33/33/30/30 dBm

8-PSK 26.5/26.5/25.5/25.5 dBm

Gain control range min. 30 dB

Phase error (RMS/peak), GMSK 5 deg./20 deg. peak

EVM (RMS/peak), 8-PSK 10%/30%
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Table 17 Receiver characteristics

Item Values

Type Direct conversion, Linear, FDMA/TDMA

LO frequencies GSM850: 3476..3576 MHz (4 x RX freq)

EGSM900: 3700...3840 MHz (4 x RX freq)

GSM1800: 3610...3760 MHz (2 x RX freq)

GSM1900: 3860...3980 MHz (2 x RX freq)

Typical 3 dB bandwidth +/- 91 kHz

Sensitivity min. - 102 dBm (normal condition)

Total typical receiver voltage gain (from
antenna to RX ADC)

86 dB

Receiver output level (RF level -95 dBm) 40 mVpp, single-ended I/Q signals to RX ADCs
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 FM radio, Bluetooth
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode
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LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver
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SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP, Official Tiku3G

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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